The **MSP-ISO** isolation board is an easy-to-use plug-in module that offers galvanic isolation between the debug and target circuits for developers (see Figure 1). This is important in cases where the emulation circuitry may adversely affect the quality of analog signal measurements made by the target central processing unit (CPU), such as an MSP430™ microcontroller.

New LaunchPad™ development kit designs from Texas Instruments provide an isolation boundary for all signals—including power and data—between the emulation and programming section and the target section of the board. This isolation is forfeited using the simple jumpers that ship with the LaunchPad development kit. The MSP-ISO Isolation board, though, connects the signals while maintaining the isolation between the two sides of the LaunchPad development kit.

![Figure 1. MSP-ISO Isolation Plug-in Module](image)
Contents
1 Getting Started ............................................................................................................ 3
2 Hardware ..................................................................................................................... 6
3 How to Use the MSP-ISO Plug-in Module ................................................................. 10
4 Additional Resources ................................................................................................. 12
5 Schematics .................................................................................................................. 17

List of Figures
1 MSP-ISO Isolation Plug-in Module ............................................................................... 1
2 SBW Clock Transmission ............................................................................................. 4
3 SBW Data Transmission (Target to eZ-FET) ................................................................. 4
4 SBW Data Transmission (eZ-FET to Target) ................................................................. 5
5 Backchannel UART Transmission (eZ-FET to Target) .................................................. 5
6 Backchannel UART Transmission (Target to eZ-FET) ................................................ 5
7 MSP-ISO Overview .................................................................................................... 6
8 MSP-ISO Pinout .......................................................................................................... 6
9 eZ-FET Revision Number ............................................................................................ 7
10 MSP-ISO Connection ................................................................................................. 10
11 MSP-ISO External Power Connection ..................................................................... 11
12 TI Resource Explorer Cloud ...................................................................................... 12
13 CCS Cloud ................................................................................................................ 13
14 Directing the Project>Import Function to the Demo Project ..................................... 14
15 When Code Composer Studio Has Found the Project ................................................ 15
16 Software Examples in TI Resource Explorer ............................................................ 16
17 Schematics ................................................................................................................ 17

List of Tables
1 ISO7321C Pinout ........................................................................................................... 7
2 ISO1541 Pinout ............................................................................................................. 8
3 TPS76333 Pinout ......................................................................................................... 8
4 TPS76350 Pinout .......................................................................................................... 9
5 Hardware Change Log ................................................................................................. 9
1 Getting Started

1.1 Introduction

The MSP-ISO Isolation board is an easy-to-use plug-in module that offers galvanic isolation between the debug and target circuits for developers. This is important in cases where the emulation circuitry may adversely affect the quality of analog signal measurements made by the target CPU, such as an MSP430 microcontroller.

New LaunchPad development kit designs from TI provide an isolation boundary for all signals — including power and data — between the emulation/programming and target sections of the board. This isolation is forfeited using the simple jumpers that ship with the LaunchPad development kit. The MSP-ISO Isolation board, though, connects the signals while maintaining the isolation between the two sides of theLaunchPad development kit.

1.2 Key Features

- Galvanic isolation between eZ-FET and target microcontroller
  - No ground connection
  - No directly connected power supply
  - No directly connected communication interfaces
- Same eZ-FET functionality with isolation
  - Bidirectional Spy-Bi-Wire
  - Debugging
  - Backchannel UART
  - EnergyTrace™ software
  - 3.3-V and 5-V isolated power
  - Ability to connect external power supplies

1.3 What's Included

1.3.1 Kit Contents

- 1x MSP-ISO Isolation Plug-in Module
- 1x Quick Start Guide
1.4 Next Steps: Looking Into the Switching Characteristics

After the plug-in modules features have been explored, the fun can begin. It's time to make some measurements using the MSP-ISO plug-in module. Section 3 describes how to use the plug-in module and properly connect it to the LaunchPad kit. For more information on where to find and download an IDE, see Section 4.

Figure 2 through Figure 6 show the switching characteristics of the isolation plug-in module. All measurements were done in Spy-Bi-Wire fast-mode on an MSP-EXP430FR2311 MCU LaunchPad development kit. The dark blue line represents the signal on the debugger side and the light blue line represents the signal on the target side of the LaunchPad kit after the isolation plug-in module.

Figure 2. SBW Clock Transmission

Figure 3. SBW Data Transmission (Target to eZ-FET)
Figure 4. SBW Data Transmission (eZ-FET to Target)

Figure 5. Backchannel UART Transmission (eZ-FET to Target)

Figure 6. Backchannel UART Transmission (Target to eZ-FET)
2 Hardware

Figure 7 shows an overview of the isolation plug-in module.

2.1 Hardware Features

2.1.1 MSP-ISO Pinout

Figure 8 shows the pinout of the isolation plug-in module.

The isolation plug-in module is designed to work with eZ-FET Rev 1.3 or greater. To locate what revision of the eZ-FET your LaunchPad development kit has, look at the emulator section of the LaunchPad development kit above the J101 header and locate the silkscreen that shows “eZ-FET Rev1.x” (see Figure 9).
2.1.2 **TI ISO7321C Dual-Channel Digital Isolator**

The ISO732x provides galvanic isolation up to 3000 V\textsubscript{RMS} for one minute per UL and 4242 V\textsubscript{PK} per VDE. These devices have two isolated channels comprised of logic input and output buffers separated by silicon dioxide (SiO\textsubscript{2}) insulation barriers. The ISO7321C isolates the backchannel UART communication lines. The reference designator for the ISO7321C is ISO1.


Table 1 lists the connections of the ISO7321C pins to the module header.

<table>
<thead>
<tr>
<th>Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J101.5</td>
<td>eZ-FET RXD</td>
</tr>
<tr>
<td>J101.7</td>
<td>eZ-FET TXD</td>
</tr>
<tr>
<td>J2.5</td>
<td>Isolated RXD</td>
</tr>
<tr>
<td>J2.7</td>
<td>Isolated TXD</td>
</tr>
</tbody>
</table>
2.1.3 TI ISO1541 Low-Power Bidirectional Isolator

The ISO1541 is a low-power bidirectional isolator that is compatible with I²C interfaces. These devices have their logic input and output buffers separated by TI’s Capacitive Isolation technology using a silicon dioxide (SiO₂) barrier. When used with isolated power supplies, these devices block high voltages, isolate grounds, and prevent noise currents from entering the local ground and interfering with or damaging sensitive circuitry. The ISO1541 isolates the Spy-Bi-Wire communication lines. The reference designator for the ISO1541 is ISO2.


Table 2 lists the connections of the ISO1541 pins to the module header.

<table>
<thead>
<tr>
<th>Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J101.1</td>
<td>eZ-FET SBWTCK</td>
</tr>
<tr>
<td>J101.3</td>
<td>eZ-FET SBWTDIO</td>
</tr>
<tr>
<td>J2.1</td>
<td>Isolated SBWTCK</td>
</tr>
<tr>
<td>J2.3</td>
<td>Isolated SBWTDIO</td>
</tr>
</tbody>
</table>

2.1.4 SN6501 Transformer Driver for Isolated Power Supplies

The SN6501 is a monolithic oscillator and power-driver, specifically designed for small form factor, isolated power supplies in isolated interface applications. The device drives a low-profile, center-tapped transformer primary from a 3.3-V or 5-V DC power supply. The SN6501 uses the 5-V supply from the eZ-FET to create an isolated 5-V supply to the linear regulators for driving both 3.3-V and 5-V isolated power rails to the target microcontroller and BoosterPack™ plug-in module headers. The reference designator for the SN6501 is U1.

More information on the SN6501 can be found at http://www.ti.com/product/SN6501.

2.1.5 TPS76333 Fixed 3.3-V Low-IQ Linear Dropout Regulator

The TPS763xx family of low-dropout (LDO) voltage regulators offers the benefits of low-dropout voltage, low-power operation, and miniaturized packaging. These regulators feature low dropout voltages and quiescent currents compared to conventional LDO regulators. The TPS76333 drives the isolated 3.3-V rail for the target side of the LaunchPad development kit. The reference designator for the TPS76333 is U3.

More information on the TPS76333 can be found at http://www.ti.com/product/TPS763.

Table 3 lists the connections of the TPS76333 pins to the module header.

<table>
<thead>
<tr>
<th>Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J3.2</td>
<td>Isolated 3.3-V enable jumper</td>
</tr>
</tbody>
</table>
2.1.6 TPS76350 Fixed 5-V Low-IQ Linear Dropout Regulator

The TPS763xx family of low-dropout (LDO) voltage regulators offers the benefits of low-dropout voltage, low-power operation, and miniaturized packaging. These regulators feature low dropout voltages and quiescent currents compared to conventional LDO regulators. The TPS76350 drives the isolated 5-V rail for the target side of the LaunchPad development kit. The reference designator for the TPS76350 is U2.

More information on the TPS76350 can be found at http://www.ti.com/product/TPS763.

Table 4 lists the connections of the TPS76350 pins to the module header.

<table>
<thead>
<tr>
<th>Header Connection</th>
<th>Pin Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J2.11</td>
<td>Isolated 5 V</td>
</tr>
</tbody>
</table>

2.2 Power

The board was designed to be powered by the attached LaunchPad development kit, and requires both 3.3-V and 5-V power rails from the J101 header. The J101 header on LaunchPad development kits not labeled with "eZ-FET Rev1.3" or greater do not match the pinout of the MSP-ISO plug-in module.

Powering schemes:

- Using the isolated power for both the onboard ISO components and the target microcontroller:
  - Place a jumper on J3
  - Place the jumper on 3.3V on J2
- Using the isolated power only for the onboard ISO components and an external power supply for the target board:
  - Place a jumper on J3
  - Remove the jumper on 3.3V on J2
- Using an external power supply for both the onboard ISO components and the target board:
  - Remove the jumper on J3
  - Place a jumper on 3.3V on J2

2.3 Design Files

2.3.1 Hardware

Schematics can be found in Section 5. All design files including schematics, layout, bill of materials (BOM), Gerber files, and documentation are available in the MSP-ISO Hardware Design Files.

2.3.2 Quick Start Guide

A Quick Start Guide is available for download.

2.4 Hardware Change Log

<table>
<thead>
<tr>
<th>PCB revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rev 1.0</td>
<td>Initial Release</td>
</tr>
</tbody>
</table>
3 How to Use the MSP-ISO Plug-in Module

To use the MSP-ISO plug-in module:
1. Disconnect the LaunchPad development kit from all power sources.
2. Remove all of the jumpers from the J101 header on the LaunchPad development kit.
3. Then plug the J101 header of the MSP-ISO into the J101 header of the LaunchPad development kit (see Figure 10).
4. Place a jumper on J3 of the MSP-ISO board to enable the 3.3-V isolated power rail.
5. Place jumpers on J2 to connect isolated signals to target microcontroller.
6. Reconnect the LaunchPad development kit power source.
7. Program the target microcontroller on the LaunchPad development kit as is normally done, using your choice of IDE (see Section 4.3).

3.1 How to Connect MSP-ISO

The MSP-ISO board extends above the emulator on the LaunchPad development kit and not towards the target microcontroller or the BoosterPack plug-in module headers. This position is to reduce any interference with BoosterPack plug-in modules the user may plug into the LaunchPad development kit.

Figure 10. MSP-ISO Connection
3.2 How to Use an External Power Source

To use an external 3.3-V power source to power the target microcontroller the user must remove the jumper from J3 on the MSP-ISO board. Then supply the appropriate voltage and ground to the LaunchPad development kit through the power header located at the bottom of the LaunchPad development kit or through the BoosterPack headers (see Figure 11).

Figure 11. MSP-ISO External Power Connection
4 Additional Resources

4.1 **TI LaunchPad Development Kit Portal**

More information about LaunchPad development kits, supported BoosterPack plug-in modules, and available resources can be found at:

- TI’s LaunchPad portal: information about all LaunchPad development kits from TI, for all MCUs

4.2 **TI Cloud Development Tools**

TI’s Cloud-based software development tools provide instant access to MSPWare software content and a web-based IDE.

4.2.1 **TI Resource Explorer Cloud**

TI Resource Explorer Cloud provides a web interface for browsing examples, libraries and documentation found in MSPWare software without having to download files to your local drive (see Figure 12).

Go check out TI Resource Explorer Cloud now at [https://dev.ti.com/](https://dev.ti.com/).

![TI Resource Explorer Cloud](image.png)

Figure 12. TI Resource Explorer Cloud
4.2.2 Code Composer Studio Cloud

Code Composer Studio™ Cloud (CCS Cloud) is a web-based IDE that enables you to quickly create, edit, build and debug applications for your LaunchPad development kit (see Figure 13). No need to download and install large software packages, simply connect your LaunchPad development kit and begin. You can choose to select from a large variety of examples in MSPWare software and Energia or develop your own application. CCS Cloud supports debug features such as execution control, breakpoints and viewing variables.

A full comparison between CCS Cloud and CCS Desktop is available here.

Go check out Code Composer Studio Cloud now at https://dev.ti.com/.

Figure 13. CCS Cloud
4.3 **Code Composer Studio IDE**

Code Composer Studio IDE Desktop is a professional integrated development environment that supports TI's Microcontroller and Embedded Processors portfolio. Code Composer Studio IDE comprises a suite of tools used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source code editor, project build environment, debugger, profiler, and many other features.


Code Composer Studio v6.1 IDE or higher is required. When Code Composer Studio IDE has been launched, and a workspace directory chosen, use `Project>Import Existing Code Composer Studio IDE Eclipse Project`. Direct it to the desired demo's project directory that contains `main.c` (see Figure 14).

![Figure 14. Directing the Project>Import Function to the Demo Project](image)

Selecting the \CCS subdirectory also works. The Code Composer Studio-specific files are located there. When you click OK, Code Composer Studio IDE should recognize the project and allow you to import it. The indication that Code Composer Studio IDE has found it is that the project appears in the box shown in Figure 15, and it has a checkmark to the left of it.
Sometimes Code Composer Studio IDE finds the project but does not show a checkmark; this might mean that the workspace already has a project by that name. Resolve this by renaming or deleting that project. Even if it is not in the Code Composer Studio IDE workspace, check the workspace's directory on the file system.

4.4 IAR Embedded Workbench for Texas Instruments MSP430

IAR Embedded Workbench™ for MSP430 MCUs is another very powerful integrated development environment that allows you to develop and manage complete embedded application projects. It integrates the IAR C/C++ Compiler, IAR Assembler, IAR ILINK Linker, editor, project manager, command line build utility, and IAR C-SPY™ Debugger.

Learn more about IAR Embedded Workbench for MSP430 microcontroller and download it at http://supp.iar.com/Download/SW/?item=EW430-EVAL.

IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to the *.eww workspace file in the \IAR subdirectory of the desired demo. All workspace information is contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by clicking Project>Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and install MSPWare software, which contains MSP430 MCU libraries and the TI Resource Explorer. These are already included in a Code Composer Studio IDE installation (unless the user selected otherwise).
4.5 **Energia**

Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and Arduino framework. Energia provides unmatched ease of use through very high-level APIs that can be used across hardware platforms. Energia is a light-weight IDE that does not have the full feature set of Code Composer Studio IDE or IAR. However, Energia is great for anyone who wants to get started very quickly or who does not have significant coding experience.

Learn more about Energia and download it at [www.energia.nu](http://www.energia.nu).

4.6 **MSPWare and TI Resource Explorer**

MSPWare software is a complete collection of libraries and tools. It includes a driver library (driverlib), graphics library (gllib), and many other software tools. MSPWare software is optionally included in a Code Composer Studio IDE installation or can be downloaded separately. IAR users must download it separately.

MSPWare software includes the TI Resource Explorer, for easily browsing tools. For example, all the software examples are shown in the tree in Figure 16.

![Figure 16. Software Examples in TI Resource Explorer](image)

Inside TI Resource Explorer, these examples and many more can be found, and easily imported into Code Composer Studio IDE with one click.

4.7 **The Community**

4.7.1 **TI E2E™ Online Community**

Search the forums at [http://e2e.ti.com](http://e2e.ti.com). If you cannot find your answer, post your question to the community.
4.7.2 Community at Large

Many online communities focus on the LaunchPad development kit and BoosterPack plug-in module ecosystem – for example, http://www.430h.com. You can find additional tools, resources, and support from these communities.

5 Schematics

Figure 17 shows the schematics, which are also included in the Hardware Design files.

Figure 17. Schematics
STANDARD TERMS AND CONDITIONS FOR EVALUATION MODULES

1. **Delivery:** TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, or documentation (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance with the terms and conditions set forth herein. Acceptance of the EVM is expressly subject to the following terms and conditions.

1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions set forth herein but rather shall be subject to the applicable terms and conditions that accompany such Software.

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned, or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production system.

2 **Limited Warranty and Related Remedies/Disclaimers:**

2.1 These terms and conditions do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License Agreement.

2.2 TI warrants that the TI EVM will conform to TI’s published specifications for ninety (90) days after the date TI delivers such EVM to User. Notwithstanding the foregoing, TI shall not be liable for any defects that are caused by neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have been altered or modified in any way by an entity other than TI. Moreover, TI shall not be liable for any defects that result from User’s design, specifications or instructions for such EVMs. Testing and other quality control techniques are used to the extent TI deems necessary or as mandated by government requirements. TI does not test all parameters of each EVM.

2.3 If any EVM fails to conform to the warranty set forth above, TI’s sole liability shall be at its option to repair or replace such EVM, or credit User’s account for such EVM. TI’s liability under this warranty shall be limited to EVMs that are returned during the warranty period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day warranty period.

3 **Regulatory Notices:**

3.1 **United States**

3.1.1 *Notice applicable to EVMs not FCC-Approved:*

This kit is designed to allow product developers to evaluate electronic components, circuitry, or software associated with the kit to determine whether to incorporate such items in a finished product and software developers to write software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference. Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 *For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:*

**CAUTION**

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

**FCC Interference Statement for Class A EVM devices**

*NOTE:* This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.
FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada

3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210

Concerning EVMs Including Radio Transmitters:

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel d'usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.

3.3 Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lads/ti_ja/general/eStore/notice_01.page 日本国内に輸入される評価用キット、ボードについては、次のとどをご覧ください。http://www.tij.co.jp/lads/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required by Radio Law of Japan to follow the instructions below with respect to EVMs:

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of Japan.

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.
【無線電波を送信する製品の開発キットをお使いになる際の注意事項】開発キットの中には技術基準適合証明を受けていないものがあります。技術基準適合証明を受けていないものご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。

1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。

上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

日本テキサス・インスツルメンツ株式会社
東京都新宿区西新宿6丁目24番1号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

4 EVM Use Restrictions and Warnings:

4.1 EVMs ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or property damage. If there are questions concerning performance ratings and specifications, User should contact a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative. During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit components may have elevated case temperatures. These components include but are not limited to linear regulators, switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the information in the associated documentation. When working with the EVM, please be aware that the EVM may become very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the dangers and application risks associated with handling electrical mechanical components, systems, and subsystems. User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees, affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal, state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as accurate, complete, reliable, current, or error-free.
6. **Disclaimers:**

6.1 **EXCEPT AS SET FORTH ABOVE, EVMS AND ANY WRITTEN DESIGN MATERIALS PROVIDED WITH THE EVM (AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 **EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS AND CONDITIONS SHALL BE CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR IMPROVEMENT MADE, CONCEIVED OR ACQUIRED PRIOR TO OR AFTER DELIVERY OF THE EVM.

7. **USER’S INDEMNITY OBLIGATIONS AND REPRESENTATIONS.** USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES, EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS AND CONDITIONS. THIS OBLIGATION SHALL APPLY WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8. **Limitations on Damages and Liability:**

8.1 **General Limitations.** IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE TERMS AND CONDITIONS OR THE USE OF THE EVMS PROVIDED HEREUNDER, REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR REINSTALLATION,ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING, OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI MORE THAN ONE YEAR AFTER THE RELATED CAUSE OF ACTION HAS OCCURRED.

8.2 **Specific Limitations.** IN NO EVENT SHALL TI’S AGGREGATE LIABILITY FROM ANY WARRANTY OR OTHER OBLIGATION ARISING OUT OF OR IN CONNECTION WITH THESE TERMS AND CONDITIONS, OR ANY USE OF ANY TI EVM PROVIDED HEREUNDER, EXCEED THE TOTAL AMOUNT PAID TO TI FOR THE PARTICULAR UNITS SOLD UNDER THESE TERMS AND CONDITIONS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM AGAINST THE PARTICULAR UNITS SOLD TO USER UNDER THESE TERMS AND CONDITIONS SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. **Return Policy.** Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s) will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the component(s), excluding any postage or packaging costs.

10. **Governing Law:** These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas, without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas. Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief in any United States or foreign court.
IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant information before placing orders and should verify that such information is current and complete. All semiconductor products (also referred to herein as “components”) are sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI's terms and conditions of sale of semiconductor products. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not necessarily performed.

TI assumes no liability for applications assistance or the design of Buyers' products. Buyers are responsible for their products and applications using TI components. To minimize the risks associated with Buyers' products and applications, Buyers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI components or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of significant portions of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional restrictions.

Resale of TI components or services with statements different from or beyond the parameters stated by TI for that component or service voids all express and any implied warranties for the associated TI component or service and is an unfair and deceptive business practice. TI is not responsible or liable for any such statements.

Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards which anticipate dangerous consequences of failures, monitor failures and their consequences, lessen the likelihood of failures that might cause harm and take appropriate remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in safety-critical applications.

In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI's goal is to help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and requirements. Nonetheless, such components are subject to these terms.

No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties have executed a special agreement specifically governing such use.

Only those TI components which TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components which have not been so designated is solely at the Buyer's risk, and that Buyer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.

### Products
- **Audio**: [www.ti.com/audio](http://www.ti.com/audio)
- **Amplifiers**: [amplifier.ti.com](http://amplifier.ti.com)
- **Data Converters**: [dataconverter.ti.com](http://dataconverter.ti.com)
- **DLP® Products**: [www.dlp.com](http://www.dlp.com)
- **DSP**: [dsp.ti.com](http://dsp.ti.com)
- **Clocks and Timers**: [www.ti.com/clocks](http://www.ti.com/clocks)
- **Interface**: [interface.ti.com](http://interface.ti.com)
- **Logic**: [logic.ti.com](http://logic.ti.com)
- **Power Mgmt**: [power.ti.com](http://power.ti.com)
- **Microcontrollers**: [microcontroller.ti.com](http://microcontroller.ti.com)
- **RFID**: [www.ti-rfid.com](http://www.ti-rfid.com)
- **OMAP Applications Processors**: [www.ti.com/omap](http://www.ti.com/omap)
- **Wireless Connectivity**: [www.ti.com/wirelessconnectivity](http://www.ti.com/wirelessconnectivity)

### Applications
- **Automotive and Transportation**: [www.ti.com/automotive](http://www.ti.com/automotive)
- **Communications and Telecom**: [www.ti.com/communications](http://www.ti.com/communications)
- **Computers and Peripherals**: [www.ti.com/computers](http://www.ti.com/computers)
- **Consumer Electronics**: [www.ti.com/consumer-apps](http://www.ti.com/consumer-apps)
- **Energy and Lighting**: [www.ti.com/energy](http://www.ti.com/energy)
- **Industrial**: [www.ti.com/industrial](http://www.ti.com/industrial)
- **Medical**: [www.ti.com/medical](http://www.ti.com/medical)
- **Security**: [www.ti.com/security](http://www.ti.com/security)
- **Space, Avionics and Defense**: [www.ti.com/space-avionics-defense](http://www.ti.com/space-avionics-defense)
- **Video and Imaging**: [www.ti.com/video](http://www.ti.com/video)

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated